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Calendar
December, 2009
1 Community Outreach – PCR: 7:00 pm.
2 Competition Night: 7:30 pm.
Judge: Susan Ruddick Bloom.
Hospitality: Lori Ducharme, Louise Roy.
3 Craft of Photography: 7:30 pm; Kent
Mason’s.
9 Program Night: 7:30 pm. Wayne
Wolfesberger. Photographing
Yellowstone National Park.
Hospitality: Gene Haddon, Jeane
Hanson.
11-13 Field Trip: Chincoteague Island, VA.
14 Photo Project Critique: 7:30 pm; Kent
Mason’s.
16 Board Meeting: 7:30 pm; Hanson’s.
17 Craft of Photography: 7:30 pm; Kent
Mason’s.

January, 2010
5 Community Outreach – PCR: 7:00 pm.
6 Competition Night: 7:30 pm.
7 Craft of Photography: 7:30 pm.
11 Field Trip: New Hampshire Ave. Trio.
11 Body of Work: 7:30 pm.
12 Body of Work: 7:30 pm.
13 Program Night: 7:30 pm.
14 Craft of Photography: 7:30 pm.
18 Photo Project Critique: 7:30 pm.
20 Board Meeting: 7:30 pm.
27 Workshop: 7:30 pm.

Competition Assignment
Monuments, Memorials,
Statues, Bridges, and WellKnown Buildings in
Washington, D.C.
The primary subject must be located
within the District of Columbia, although the photograph can be taken
from Maryland or Virginia. (Must
have been taken on or after June 1,
2008.)

Editor: José Cartas

North Bethesda Camera Club
nbcclensandeye@yahoo.com

December Judge
Susan Ruddick Bloom
Marvin Sirkis
Susan Ruddick Bloom is known for
her fine art photography. She uses
alternative photographic processes
and digital manipulation. Sue has
been involved in making art on the
computer for over twenty-five years.
She holds a BFA and a MFA from
the Maryland Institute College of
Art. She is Professor and Chair of
the Department of Art and Art
History at McDaniel College, in
Westminster, Maryland.
In addition to her college teaching
and exhibitions, Sue conducts
classes at many of the top photographic workshops, including the
Maine Media Workshops, Palm
Beach Photographic Centre, Santa
Fe Photo Workshop, Common
Ground, and Common Ground—
Scotland. She also leads photo
tours throughout the world.
Sue's book, Digital Collage and
Painting, by Focal Press, was
released in 2006, and has been
translated into Chinese and Russian. This 608 page book is seen
as the Bible for digital collage and
painting manipulation and is used
as a text in colleges with a digital
fine art curriculum. A second,
revised version of that book is
scheduled for release in Fall 2010.
Sue's new book, Digital Painting in
Photoshop, was released in February 2009.
Cont’d on p.3
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Program Night
Wayne Wolfersberger
Photographing Yellowstone
National Park
Jim Hawkins
An ecologist-naturalist and educator by professional training, and a
nature photographer by passion,
Wayne has integrated both areas
to become a well respected nature
photographer in the area. His photographic expertise was honed
while working for a D.C. area commercial photography firm, the U.S.
Navy and involvement in numerous seminars and workshops.
Wayne is a member of NANPA
(North American Nature Photography Association), the Vienna Photographic Society and Northern
Virginia Photographic Association,
for which he served as VicePresident and President. Wayne
has delivered numerous and varied
photographic programs for many
local groups and also in the United
Kingdom and Australia. Many of his
images have appeared in national
Cont’d on p.3

Photo Essay
Proposals
are due on
December 2
ProShow article on page 5

The content and photographs of The Lens and Eye are copyrighted. Articles may be reproduced citing the newletter as their source.
An electronic copy of the publication using the material must be sent to the editor at nbcclensandeye@yahoo.com.

Member Profile
Steve Gelband

Steve Gelband is eager to reconnect with his camera since his
retirement from a demanding career
in law. Although his initial interest
was sparked by the mechanics of
photography, he is now motivated
to master the artistic aspects of the
craft. When he was six or seven
years old, Steve placed a tree leaf
against photographic paper and
saw a silhouette of the leaf appear
on the page. He was hooked! His
father encouraged his interest by
giving him a Kodak Brownie Box
camera and by helping him to set
up a darkroom under a stairwell in
their Mount Vernon, NY, home.
In high school, Steve carried a camera almost everywhere with him
and was constantly on the alert to
shoot images for the school newspaper and yearbook. He began to
realize that the images could have
artistic as well as technical merit.
His favorite camera during this
time was a Graflex "Speed Graphic,"
a press photographer camera that
used 2¼" X 3¼" film and produced
wonderfully sharp negatives.
After high school, Steve put his photography on hold and worked to
earn a BA from Yale and a JD from
Harvard Law School. He passed the
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New York State bar exam in 1955.
Then he got drafted for a two-year
tour of duty with the U.S. Army. He
trained as a clerk-typist at Fort Dix,
received a Crypto clearance, and
was assigned to the Office of the
Joint Chiefs of Staffs at the Pentagon. On his first day on the job,
however, he was told that he was
not needed as a mimeograph machine operator there, and that he
should look for a legal position elsewhere in the Army. He found a job
in the JAG office at Fort Myer,
where he acted as a law advisor to
enlisted men.
Meanwhile, other things were happening in his life. When not immersed in photography, Steve had
somehow managed to meet a
young lady at the local country
club. Carla Shapiro was 14 and
Steve 17 when they met. They were
married eight years later, just before he entered the military service.
Carla had one more year of college to go. She completed it after
the wedding and got her degree.
She elected to become a teacher
and has since enjoyed a successful career of many years duration.
Steve and Carla have two children
and four grandchildren. Scott was
born in 1960, trained as a lawyer,
and lives in Seattle. He and his
lawyer wife have two children. He
now spends time running a group
he founded that brings musical experiences to underprivileged children
in after-school hours. Joanna was
born in 1963 and is now a Union
Organizer for clerical and technical
workers at Harvard University.
During her high school years, she
assisted with photography classes
at Glen Echo Park.
After the completion of his tour of
duty with the Army, Steve and Carla
decided to settle in the D.C. area.
He found his first employment with
the Civil Aeronautics Board. He
later became a partner in a private
law firm and subsequently founded
his own firm.

During a long and varied career,
Steve specialized in transportation
law and represented a variety of
airline companies, both domestic
and international. He was also
founder of the Washington Airports
Task Force, a non-profit publicprivate sector organization specializing in the promotion of local area
airports. Among its activities, the
Task Force analyzes local air service needs and advocates new
services to candidate airlines, supports funding for additional personnel, and works to improve ground
transportation to Dulles International Airport. It also participates in
all international aviation negotiations and DOT route award proceedings that could benefit the
airports it represents.
During his working career, Steve
and Carla traveled the world free,
courtesy of his client airlines. Steve
always carried a camera around
and made hundreds of images.
Prints of his best ones hang in
their home and in the family vacation place in Frederick, MD.
In 2002, Steve bought his first digital camera. He now owns a Nikon
D300 and a Canon G9. He postprocesses in Photoshop CS3 and
prints with an Epson 2400. He has
taken Photoshop courses at the
Smithsonian with Eliot Cohen and
has done night photography with
David Luria. He has also participated in a number of NBCC field
trips. His favorite subjects are
architectural details and "found
objects" such as rusty old gas
tanks. He is currently competing in
the Novice Electronic Category.
Steve was introduced to the NBCC
when Eliot Cohen mentioned it
favorably in one of his classes.
Steve researched it on the Internet
and decided to join. He was on the
waiting list for a year. Now he is
enjoying the opportunity to learn
and to improve his craft.
Text and Photo by Jean Hanson
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Susan Ruddick Bloom (cont’d from p.1)
Sue writes articles for leading photography magazines including Shutterbug and After Capture. She is
a regular contributor to Australia's Better Photoshop
Techniques. Her work may be viewed at
www.suebloom.com.

NBCC Field Trip – December 11–13
Chincoteague Island
Nikhil Bahl
The NBCC December field trip will be to Chincoteague Island. We have reserved a block of rooms at
the Best Western for Friday, December 11 through
Sunday, December 13 (Friday and Saturday night). If
you plan to attend, we recommend you make your
reservations soon. The group rate is $52 + tax per
night. To make your reservations please call the Best
Western Hotel directly at 757-336-6557. Mention
that you are with the North Bethesda Camera
Club to get the group rate.

Program Night, December 9 (cont’d from p.1)

If you plan to attend, please be prepared to deal with
temperatures close to the freezing mark and possible
wind chill as well. What you can expect to photograph
are the snow geese that migrate and some that
winter in the refuge. It is very likely that you will have
opportunities to photograph a few other species of
birds as well. There are also plenty of photo ops at
the beach. This is generally a quiet time at
Chincoteague, with the people and mosquitoes not
around. The gallery below will give you an idea of the
opportunities you might have (note: some of the bird
species might not be around in December):
http://www.nikhilbahl.com/portfolios/chincoteague/ind
ex.html.

magazines (including three images in Nature’s Best),
on calendars, postcards, and are exhibited as fine art
prints. During the spring and fall, Wayne teaches a
variety of photography classes for Fairfax County
Adult and Community Education, but during the
summer you will find Wayne in Yellowstone working
for the United States National Park Service.

If you plan to attend, please make your reservations
at the earliest and e-mail Deeva Garel at
diwg2000@yahoo.com to let her know you will be
joining us. She will send you some more details about
the field trip. Informing her will also help with making
reservations at the local restaurants for dinner on
Friday night.

“Icelandic Watercolor” © Susan Ruddick Bloom

On December 9, Wayne will present for our pleasure,
and education, spectacular images that he has
captured at Yellowstone National Park, and guide us
to special places that we might find in Yellowstone to
photograph for ourselves!

“Bull Bison Fight During Rut” © Wayne Wolfesberger
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Photo © Nikhil Bahl
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November, 2009, Splinters from the Board
Tom Sullivan, President
A revised procedure for reporting the secretary's
minutes at the board meetings was settled. Henceforth,
the minutes will NOT be read at the meeting. Instead,
the president will select important highlights from the
written report submitted by the secretary and only
these items will be read at the meeting. The minutes,
as prepared by the secretary, will be sent out via email to board members several days in advance of
the meeting for comments, corrections and additions.
The video tapes, CD's and DVD's that make up our
library will be transferred from our librarian to our
Training Committee Chairman, Kent Mason. These
materials will no longer be available for borrowing at
club meetings. They will be housed at Kent Mason's
house and available to participants of Kent's classes.
Kent will bring individual items to meetings if specifically requested by a member. The list of items available will be maintained on the Club's web site.

Judy Burr, NBCC PSA representative
The October issue of PSA Journal starts with On My
Mind, a column by Elena McTighe, APSA, the Publications Vice-President. She and two others plan and
assemble the magazine every month and just like our
club newsletter, once one is done, it is time to start
the next one. PSA has a diverse membership and
they try to cover many different subjects. If you have
a suggestion for subjects you would like to see, let
me know and I will pass them along.
Apparently, there is not much interest in NBCC to
enter in PSA’s club competitions, but there is one
coming in January that may be attractive. Adobe is
sponsoring the “Top Photo” Contest that will award
the club coordinator a free six-month trial of Adobe
Lightroom 2 that must be used in the club’s image
collection and selection process. Prizes include
Adobe Lightroom2, Adobe Photoshop CS4 and a
two-day Adobe Lightroom 2 workshop with Jerry
Courvoisier (a $395 value). Clubs may enter two images by different members. The closing date is January 15, 2010. If a member of NBCC would like to take
this task on, both member and club would benefit.
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This month, “Drury’s Digital Diary” discusses LAB
Color Space because he says that there are times
another color space will do a better job. LAB images
can be converted from RGB as well as from CMYK to
LAB. Photoshop is built to use LAB; and layers,
masks, etc. can be used but will work differently. Drury
will continue his discussion in the November issue.
The history series this month covers the PSA
Journal—it has evolved considerably in 75 years!
PSA is now offering an image analysis course to
members of member clubs and for individual PSA
members.
See
http://psaclubservices.org/club_services/judging_services.html.
The course is designed to help students evaluate
work within the framework of PSA-recognized international exhibitions and the camera club environment. This is a first step to becoming a judge. It would
likely help in NBCC critique sessions, too. The 12
lessons must be completed in three months and
consists of 24 images that must be evaluated.
There are several software reviews that may help in
deciding which would help in processing photos.
They are: SmartMask v. 2.5, ProShow Style Pack
Volume 2, Styles Bundle Volumes 1 and 2, and
Essentials 2. Perhaps, NBCC members could do
some software reviews for The Lens and Eye! The
“New Member Gallery” this month features Region I,
which includes Maryland, Delaware, Washington,
D.C. and eastern Virginia. The Mid-Atlantic Chapter
entered the Chapters Showcase and one of the
members, Brenda Gillum was awarded First Runnerup and the chapter was in second place overall.
John Barclay wrote an article on creative images that
describes camera movement, multiple exposure and
image overlay, and accompanies it with lovely photos
showing the techniques. He refers to Freeman Patterson while stating that a place does not have to be
photographed literally, but rather with a sense or
feeling of a place. Sometimes, we need reminders to
look outside the box when we use our cameras.
For those who have been to India or want to go, there
is a photo filled article on “Faces of India” and the
final article is on landscape photography and opens
with the words “In landscape photography the best
time to shoot great images is at sunrise and sunset.
The time in between is known as breakfast, lunch and
nap-time” and ends with “After the light is gone it’s
time for dinner, downloads, back-ups, and critiquing
the results of the day’s work. That effort invariably
produces great improvements on the second day.”
This could be applied to Club field trips—go back the
next day and do better.
December, 2009

Photo Essays and ProShow Software
Text by Stuart Mathison

Why Photo Essays?
NBCC members have lots of photos … tens of thousands of them … How can we share our best images
with others? A dynamic and engaging way to share
images is to create photo essays of a family event, a
vacation trip, an interesting place, a life history or a
body of work, with lively and engaging music.
Photo essays can be shared in many different ways.
They can be saved on a CD and viewed on a PC,
saved on a DVD and viewed on a TV, posted on
websites, and presented in our annual Photo Essay
Show in March.

Creating Photo Essays
There are several parts to creating essays: first,
selecting the topic, images, and music, and sequencing these in an artistic way; and second, using PC
software to organize and present the images and
music in a high quality and engaging format.
This article focuses on preparing photo essays
utilizing ProShow Gold software by Photodex Corporation, which is required for NBCC essay programs,
and is considered by many to be the best photo
essay software currently available.
Two versions of ProShow software are available for
the PC platform: ProShow Gold ($70) and ProShow
Producer ($250). ProShow software is not available
for the Mac platform.
ProShow Gold (PSG) is more than adequate for most
club members. ProShow Producer (PSP) provides
templates, styles and features designed for professionals who produce essays for clients (e.g., weddings, fashion photography, portraiture, etc.).

Preparing Photo Essays with ProShow
Software
Show Duration and Timing
Assume six seconds for each slide in your essay,
including time for transitions. For NBCC’s “Photo
Essay 2010,” we recommend a show duration of four
minutes or less, and not more than 40 images.
Select a music file with duration similar to the overall
show duration (e.g., four minutes). You can also use
multiple shorter music pieces sequentially, or a longer
piece and trim it within PSG. Music files are obtained
by “ripping” the music from a CD, or downloading the
music from online sites such as iTunes or Amazon.
December, 2009

MP3 files are preferred, since they provide good
quality and are not subject to “digital rights
management” limitations. However, note that virtually
all music is copyrighted, and can only be used for
“non-commercial” purposes without obtaining a
license.
Image and File Preparation
After selecting your images, resize them in Bridge or
Lightroom to match the screen resolution of your
planned display device. For the Club’s projector, this
is 1,400 x 1,050. If your output is to be shown on an
HD TV, then resizing it to 1,920 x 1,080 would be
appropriate. If images in your essay will be zoomed
or panned, then you should resize them to twice the
above dimensions. PSG supports all common image
formats (JPEG, TIFF, and PSD), while PSP also
supports RAW files. Most users create JPEGs for
ProShow.
ProShow also supports insertion of video into photo
essays, and many video input formats are supported
including Windows .AVI, Quicktime .MOV and .MPEG.
While you can easily re-order images within PSG, it is
advisable to rename all your images in Bridge or Lightroom in the approximate sequence you want them,
especially if your show is very long (hundreds of
images). You will optimize the sequence later in PSG.
Organize all your essay files into a single master
folder, with subfolders for your images and your music.

Creating a Quick Essay
Open PSG and click “New” to start your essay. Select
your title and aspect ratio (4:3 for standard TV or 16:9
for HD TV). For essays to be projected, the standard
format is 4:3.
From the “folders list panel” find your essay folder.
Select all your images and import (drag and drop)
them into the “Slide List” panel. Import (drag and
drop) your music file(s) into the “Soundtrack” panel.
(Note that your original image and music files will not
be moved on your hard drive.)
Synchronize your slides to your music by clicking
“Audio>Synch Slides to Audio.”
PSG will then create your show using default options:
three seconds per image, three seconds for transitions, and a dissolve type of transition. Also, each image will be scaled to fit within the projected frame,
without changing the image proportions.
You can adjust the show options at any time by
clicking “Edit>Preferences”.
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Note the “Preview panel,” which displays any slide
selected on the “Slide list”. Also note in the upper
right of the “Preview panel” the number of slides and
the duration of the music files.
To preview your essay, click on the “Play” button on
the top. The essay will play in the Preview panel. To
preview the essay in “Full Screen” mode, right click in
the preview window and select “Full Screen
Playback” and click the “Play” button. Click the
“escape key” on your keyboard to escape from “Full
Screen Mode.”

Optimizing the Essay
Now the fun begins. After previewing the essay, you
may want to change the slide sequence, remove or
add images, increase the duration for your complex
images, change the duration of the transitions,
change the type of transitions, and/or edit some images. You may want to add motion to certain images,
such as slowly zooming in toward the “point of interest”, or panning across a landscape. You may want to
edit the soundtrack to make it shorter, or to pick the
best section of the music. You may want to synchronize the slide transitions to the crescendos in the
music. PSG provides tools for making all these
changes and more.
Slide Sequence. To rearrange the slide sequence,
click and drag images in the Slide List to the right or
left to reposition them. Or cut and paste one or more
images in the slide list to reposition them. Alternatively, PSG provides a “Lightbox” which displays a
larger number of slides. To display the Lightbox panel
click on Window>Show>Lightbox and then drag and
drop images to reposition them. Click on Window>
Show to open and close any panels.
Timing. To change the timing, you can alter the slide
and/or transition duration for any slide or group of
slides or for the whole show. Under each slide in the
“Slide List” is the number of seconds the slide is
displayed prior to the transition. To the right of each
slide is the number of seconds for each transition.
You can change any of these numbers individually, or
select a group of images and change one number
and the change will apply to all the images in the
selection.
Transitions. PSG provides 280 different transitions.
To the right of each image in the Slide List is an icon
for a specific transition. Click on the icon and a panel
of transitions appears. Hover the cursor over any icon
in the panel and the transition will be shown dynamically. Click on an icon to select it. Simple transitions
work best in most photo essays.
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Music Trimming. Music can be edited by right
clicking the Soundtrack and selecting “Edit Fades and
Timing”. A graphic image of the soundtrack is displayed and you can select which portion of the music
track to use, (i.e., adjust the point at which the play
begins and ends) and adjust the amount of fade-in
and fade-out.
Music and Slide Synchronization. If you click the
tab key, the Soundtrack will expand. Note that the
Slide List is immediately above the Soundtrack. You
can synchronize the slides to the music by selecting a
slide on the Slide List and moving the start-slide and
end-slide markers to coincide with the music ups and
downs shown in the Soundtrack.
Motion. Zooming and panning and other “motion
effects” allow essays to highlight areas of interest
within images. PSG offers many options for adding
motion to slides, as well as other special effects. To
apply special effects to a slide, double click the slide
in the Slide List, and a “Slide Options” window will
open showing the slide modifications available. One
option is “Effects”. Click on this tab and the window
will show starting and ending images. You can zoom
or reposition the starting image and the ending image. When you playback the show, PSG will gradually move the image from the starting to the ending
version. You can use this feature to zoom in or zoom
out, to pan in any direction, and to rotate images.
Slide Style. PSG provides many preset “styles” that
can be applied to slides. In the Slide Options window,
click on “Slide” and you will see a list of available
styles, including a moving backdrop, a picture frame,
colorizing grayscale, colorizing sepia, and multiple
image formats.
Captions. Captions are another “Slide Option” and
can be added to any slide with all the usual text fonts
and sizes, drop shadow, caption positioning, and
various “fly-in” and “fly-out” options.
Layers. PSG allows multiple images to be displayed
on one slide by allowing unlimited layers. Layering
allows for creation of collages, masking and applying
motion effects to layers.
Sounds. Narrations and other recorded sounds can
be added to individual slides. Narrations can be prerecorded or added during essay creation. Sounds
such as bird calls or applause or scene sounds can
be pre-recorded.
Templates and Media. Photodex provides a variety
of templates and media for photo essays in separately sold “Stylepacks” and “Mediapacks”. Stylepacks are collections of high-quality, instant slide enhancements that expand the initial Slide Style offerDecember, 2009

ings and animations in PSG and PSP. Mediapacks
provide content, backgrounds, templates and audio
tailored to particular applications, such as weddings,
portraiture, and family memories. These are mainly
used by professional photographers.

Create Output
As noted, there are many forms of output for your
essay including:
 For TVs
o DVD – Plays in any DVD player
o Blue-ray – Next generation HD disc
 For the Internet
o YouTube – Upload to YouTube website
o Flash – Flash video for the web
o Photodex website – Free hosting/sharing
o Webshow – Web show for your own site
 For computers
o PC executable file – Self-contained file
o Video file – Various types of video files
o Autorun CD – PC shows that play from a CD
 For devices
o Cellphones
o MP3 players
 Other
o Screen saver

Mathison (Basics, Mastering Audio, and Using Layers).
www.proshowenthusiasts.com. An online forum for
ProShow users.
There are two ProShow User Groups that contain a
lot of helpful information:
http://tech.groups.yahoo.com/group/proshowgroup. A
user group for ProShow Gold.
http://tech.groups.yahoo.com/group/psproducer. A user
group for ProShow Producer
For information on topic selection and the creative
aspects of essay making see:
www.photocentric.net/HowToCreatePhotoEssays.pdf.
For information on the procedures for NBCC photo
essay programs see:
http://nbccmd.org/docs/PhotoEssayPreparation2009.pdf
Examples from Past NBCC Photo Essay Shows
Essay Topic/Title

Description

On Stage

The beauty of Chinese
performance arts

Butterflies

Macrophotography

Eclectic Colors

Images dominated by color

New York, New York

Sounds and sights of NYC

What a Wonderful World

The world in pictures

India

Colorful and diverse India

Waltz of the Flowers

Floral macro-photography

Cappadocia to the Sea

Western Turkey

Sources of Information

Birds by the Water

Birds from afar

Extensive information on the use of ProShow software is available from the following sources:

Arizona Colors

Colorful landscapes

Faces Along China’s Silk
Road

Ethnic groups in Western
China

ProShow User Manuals. Can be downloaded from
the Photodex website as a PDF or acquired in hard
copy form when the ProShow CD is purchased.

Hybrids and Surreal

Abstracts

Colorado Plateau

Landscapes

Majestic Italy

Choral groups in the Vatican

The Official Photodex Guide to ProShow 4 by James
Karney (July 2009)

Dolly Sods, West Virginia

Photographer’s paradise

Fire and Water

Photodex ProShow: Visual Quickstart Guide by Jon
Canfield (April 2009)

Abstract art from burnt old
vehicles and buildings

Amish Country

An old way of life preserved

Websites

The Monasteries of
Armenia

Religion and architecture

Robyn’s Garden

Views of a lovely private
garden

This Ole House

Abandoned and broken
down old houses

Iceland

Unusual topography and
flora

The most common forms of output are PC executables and DVDs. Detailed instructions for creating
output are beyond the scope of this article, but
ProShow provides comprehensive guidance in the
user manuals and help files.

Books

www.photodex.com. Extensive tutorial materials including product and feature demos, online classes and
training DVDs, tips and tricks and “how-to” demos,
sample photo essays, and FAQs. Unlike other major
software providers, Photodex also provides excellent
customer service, both by e-mail and by phone. Several ProShow training DVDs are available from Stu
December, 2009
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The Hurtigruten
Text and Photos by José Cartas
It was not difficult for my wife Sylvia to convince me to
take a trip along Norway’s coast to celebrate our 25th
wedding anniversary. Although I am not a fan of
cruises, I have always wanted to visit the country, so I
found the idea to be a good compromise. From all the
available options, we decided on the mail ship that
travels daily between Bergen (in the south) and Kirkenes (in the very north), carrying mail, goods, local
passengers between towns and, of course, tourists.
The Hurtigruten (“fast route” in Norwegian) was the
idea of a national steamship advisor, to provide express boat service between Trondheim and Hammerfest. After two large steamship companies turned
down the offered route, a relatively new one took up
the challenge and entered into a four-year contract
with the government for a weekly service between the
two cities. The maiden voyage took place on July 2,
1893. As time passed, more shipping companies
followed, the route was extended from Bergen to
Kirkenes, the frequency became daily, and tourism
became more and more central to the operation.
We spent our first day
in Bergen, Norway's
second largest city. Surrounded by seven hills
and seven fjords, it is
a very colorful city, with
its historic Bryggen
("wharf") district listed
as a UNESCO World
Heritage site. Bryggen
is the city's oldest and
most charming quarter,
with a collection of
around 60 wooden
buildings from the
early 1700's. Archeological excavations are
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continually going on in the quarter. Walking from
downtown Bergen to the Bryggen district, one passes
through a lively fish market. To my surprise, most of
the vendors spoke Spanish: they were young people
from Spain doing summer jobs there!
In the afternoon we boarded the Nordstjernen, which
happened to be the oldest and smallest ship of the
fleet. Built in 1956, it has a capacity of 400 passengers and 168 berths. Although small, our cabin was
comfortable enough. The size of the ship was ideal
for photography, since I could walk from bow to stern
in less than a minute, something not possible on the
larger vessels. Because the route combines mail
delivery with tourism, the ship calls at several ports to
let passengers go ashore. Depending on the city, the
stops spanned from 15 minutes to several hours; and
sometimes 15 minutes were more than enough to
see all what there was to see.

The morning of the second day I woke up at around
4:30 am, just in time to catch the sunrise. I was glad I
did it, because for the rest of the trip it was always
cloudy and rainy at daybreak. It was a good opportunity to see the rugged coast of Vestkapp, a 1,500 feet
high, 20 mile long mountain ridge that marks Norway's
westernmost point. It also provided a lot of chances to
photograph small boats braving the waters during the
early hours.
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On this second day, after stopping briefly in Ålesund,
the ship deviated from its northbound route to enter
the Storfjord, which extends more than 60 miles into
the continent. One of its arms, the Geirangerfjord, is a
ten-mile long, 950-feet deep stretch often labeled as
one of the most spectacular fjords in Norway. And
with good reason too, because here mountains up to
5,200 feet high covered by snow are visible, along
with precipices right down into the deep green/blue
water. At its very end lies Geiranger, the pleasant
agricultural village for which the fjord is named. All
along the way, water drops from the mountains,
forming various different falls with names like "The
Seven Sisters," "The Suitor," or "The Bride's Veil."
On the third day we stopped for the whole morning in
Trondheim, the country's third largest city and Norway's original capital. The city has two main attractions: the Nidaros Cathedral (Nidaros was Trondheim's original name) and the bright 17th- and 18thcentury warehouses along the Nidelva ("Nid river," in
Norwegian). The Cathedral was constructed in the
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late 11th century and is Scandinavia's largest medieval building. It was the site of the Norwegian archdiocese, from its establishment in 1152 until its abolition in 1537. Since the Reformation, it has been the
home of the Lutheran bishops of Trondheim. Its west
facade has top to bottom statues of biblical figures,
and Norwegian bishops and kings. The warehouses
facing the Nidelva served as storage facilities and
could be reached from both the river (where boats
could load and unload cargo) and from the land.
Today, they have been converted into restaurants,
offices, and even into apartments.
The fourth day brought two highlights. Early in the
morning we crossed the Arctic Circle. The night
before we had to fill out a form, guessing the exact
time of the crossing. The winner was announced on
the fifth day, during a ceremony in which passengers
were awarded a certificate after going through a
"baptism" of ice cubes on their backs. Incidentally,
Sylvia missed the prize by just a couple of seconds.
In the evening, after leaving Svolvær―the "capital" of
the Lofoten Islands―our ship entered the Raftsund, a
12-mile long strait that cuts through the rocks between two islands, with peaks towering more than
3,000 feet above sea level. If the experience of
navigating the Raftsund was special, it turned almost
mystical when the captain steered the ship west into
a 300-feet wide rocky opening that gives access to
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the one mile long
Trollfjord. It was
already 11:30 pm,
cloudy, and a
dense fog settled.
However, since it
was summer, with
its midnight sun, I
was not only able
to enjoy the view,
but also to shoot
handheld! Being
so close to these
high walls while
contemplating the
calm waters was
seeing nature at
its finest. This feeling was surely
shared by all passengers because suddenly, without any warning,
everyone on the deck stopped talking and a deep
silence reigned until we left the fjord and continued
back on the Raftsund.
We had other exciting views during the rest of our
journey. For instance, we made port in Tromsø, "the
gateway to the Arctic," with its Ishavskatedralen
(Arctic Cathedral), where midnight concerts are
staged daily in summer. Our ship came as close as
1,300 miles to the North Pole; from there, Sylvia took
a separate excursion and reached North Cape, the
northernmost point in continental Europe (71º 10' 21"
north). It was also very interesting to see tiny villages
along the coast, far from each other and many of
them connected with the rest of the world only by
boat; what is even more amazing is that such far-end
places were already settled 10,000 years ago. It was
also odd to wake up at 2:00 or 3:00 am, look outside,
and see everything bathed by the twilight.
After six nights on board, we arrived on the morning
of the seventh day in Kirkenes, 240 miles north from
the Arctic Circle, ten miles from the Russian border,
and approximately at the same longitude as Cairo.
There, we rented a car and drove 1,700 miles back to
Oslo. But that is another story.

Exhibits
Faces of the Frontier: Photographic Portraits
from the American West, 1845–1924
The American West was dramatically remade in the
eight decades between the beginning of the Mexican
War and the passage of the Indian Citizenship Act in
1924. This exhibition tells the story of those changes
through the photographs of the men and women who
helped define this era. Although the history of the transMississippian West is many centuries old, the period
beginning with the annexation of Texas in 1845 and
the outbreak of war with Mexico in 1846 saw everincreasing encounters between people of different
cultural traditions and circumstances. These individuals played a significant role in the exploration,
settlement, and representation of this vast territory.
At the same time, the new visual technology of photography, first introduced in 1839, reshaped the way
Americans and others came to understand the West.
More than any literary or artistic medium, photography made visible the region's great natural and
human diversity. Although photography often reinforced popular notions, it also presented new ideas
about the West—and in the process about America
itself.
At the National Portrait Gallery, through January 24,
2010. For more information visit www.npg.si.edu.

Outwin Boochever Portrait Competition 2009
Every day we are inundated with faces. Images of
celebrities, acquaintances, and friends—in the news,
on social networking sites, on the street—are constantly changing. Portraits, on the other hand, slow us
down. They capture the artist's carefully conceived
approach to the subject, whether a friend, a loved
one, or a self-portrait.
For this exhibition, the second in an ongoing series,
the National Portrait Gallery held an open competition, asking artists throughout the United States to
submit likenesses of people close to them. From
more than 3,300 entries from every state, a jury of
experts chose forty-nine works of art in a variety of
media, including painting, sculpture, drawing, video
and new media, and photography.
At the National Portrait Gallery, through August 22,
2010. For more information visit www.npg.si.edu.

Still running
Polar Obsession: Photography by Paul Nickeln, at the
National Geographic Museum, through February 15, 2010.
In the Darkroom: Photographic Processes, at the
National Gallery of Art, through March 14, 2010..
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November Competition 1st Place Winners — Automobiles, Trucks and Motorcycles
Print

Electronic

Black & White – Chris Hanessian – “Chrome”

Novice – Jay Gartenhaus – “Old Stud”

Advanced – Carl Root – “Burned Out”

Novice Color – John Barnes – “Flying”

Advanced Color – Chris Hanessian – “Harley”

December, 2009

Altered – Stu Reiter – “1941 Buick”
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Results of Competition for November 2009 – Automobiles, Trucks
and Motorcycles
Competition Judge: Duane Heaton
Electronic

Prints
Black and White – 10 entries
st

1
2nd
rd
3

Chris Hanessian
Chris Hanessian
Chuck Bress

Chrome
Ford
Fins

Color, Novice – 8 entries
st

1
2nd
rd
3

John Barnes
Cheryl Naulty
Bill Olson

Flying
Fire Truck on the Fourth
Morning Rush

Color, Advanced – 14 entries
st

1
nd
2
3rd
HM
HM

Chris Hanessian
Beverly Gordon
Chuck Bress
Les Trachtman
Beverly Gordon

Harley
Nature Wins
Whitewall Tire
Havana Taxi
Going Green

Ask Tim Grey
I recently captured an image along a rocky coast
in Maine right around sunset, with amazing warm
lighting. The digital capture does not have the
vibrant colors I saw there, and boosting the saturation (even using the new Vibrance adjustment
in CS4) is not giving me good results. Is there a
way to recover the color that has been lost?
I have seen many examples of the issue you describe, and have talked to a great many photographers about exactly this sort of challenge. It is
relatively common to have an image not reflect the
rich, saturated colors we remember (or think we
remember) from a given scene. Quite often, simply
boosting the saturation will not provide a good solution because there is not enough actual color (variation from neutral values) to be properly affected by
that boost in saturation. Instead, you need to apply an
adjustment that will introduce some color first, and
then boost that color with a Vibrance (my preference)
or Hue/Saturation adjustment.
In most cases, the easiest solution is simply to shift
the color balance in the image to bring in the rich
colors you remember. To do so, add a Color Balance
adjustment layer and shift the Red/Cyan slider slightly
- 12 -

Novice – 27 entries
st

1
2nd
rd
3
HM
HM
HM
HM
HM
HM

Jay Gartenhaus
Cynthia Hunter
Stu Reiter
Jay Gartenhaus
Rob IJsselstein
Allen Melser
Dawn Sikkema
Paul Taylor
Beth Wensley

Old Stud
Sunset Traffic
Rush Hour
Red Buick
Yellow Dodge
Luck on the Road
Lost on Belle Isle
Street Reflection
Floorboard Relfections

Advanced – 37 entries
st

1
nd
2
3rd
HM
HM
HM
HM
HM
HM
HM

Carl Root
Carl Root
Bob Peavy
Judy Burr
Melissa Clark
Bruce Davis
Alex Guo
James Hammack
Frank Herzog
Angelique Raptakis

Burned Out
Door Detail
On the Brink
Rusty Truck
Red, White and Chrome
Wheels
Overloaded
All Blue
1957 Corvette
Italian Stallion

Altered – 21 entries
(one winning entry was disqualified)
1st
nd
2
rd
3
HM
HM
HM

Stu Reiter
Paul Taylor
Allen Melser
Judy Burr
Judy Burr
Paul Taylor

1941 Buick
Open Road
OC Support
Chrome Exhaust Pipes
Trapper Creek Car
Motoring

toward Red and the Blue/Yellow slider slightly toward
Yellow. In most cases you will want to make a bigger
adjustment toward Yellow than toward Red, but it will
depend in part on the content of the image. After you
have shifted the color balance for the image, then add
a Vibrance adjustment layer and increase the Vibrance value to boost the colors (or use the Saturation in Hue/Saturation if you are using a version of
Photoshop prior to CS4).
Reproduced with Tim Grey’s permission from his e-mail service
(www.timgrey.com).
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Cumulative Scores for 2009-2010; Through November, 2009
Black and White Prints
29
27
17
14
6
6

Chris Hanessian
Bill Olson
Bill Seelig
Chuck Bress
Jay Gartenhaus
Sharyn Greberman

Advanced Color Prints
32
16
15
12
12
9
9
8
8
8
6
6

Angelique Raptakis
Chris Hanessian
Beverly Gordon
Don Martell
Bill Richards
Willem Bier
Roy Sewal
Chuck Bress
Alan Sislen
Jean Yuan
Bob Dargel
Les Trachtman

Novice Color Prints
27
25
17
10
8

Bill Olson
Marvin Sirkis
Cheryl Naulty
John Barnes
Jack Tierney

Novice Electronic
36
28
24
18
15
12
12
8
6
6
6
6
6
6

Paul Taylor
Jay Gartenhaus
Stu Reiter
Cynthia Hunter
Allen Melser
Dawn Sikkema
Beth Wensley
Stuart Levy
John Barnes
Steve Gelband
Rob IJsselstein
Cheryl Naulty
Martha Reeser
Michael Roberts

Advanced Electronic
36
19
18
16
16
14
12
12
12
8
8
6
6
6
6
6
6

Alex Guo
Carl Root
Frank Herzog
Willem Bier
Evelyn Jacob
Kent Mason
Bruce Davis
James Hammack
Angelique Raptakis
José Cartas
Bob Peavy
Judy Burr
Melissa Clark
Lester LaForce
Don Martell
Janet Myder Hammack
Rebecca Tidman

Altered Electronic
19
18
18
16
15
15
14
8
6
6
6
6
6

Stu Reiter
Judy Burr
Sharyn Greberman
Evelyn Jacob
Janet Myder Hammack
Paul Taylor
Jim Hawkins
Allen Melser
David Davidson
Frank Herzog
Michael Roberts
Jess Stansbury-McCargo
Anita van Rooy

"To photograph truthfully and effectively is to see beneath the surfaces and record the qualities of nature
and humanity which live or are latent in all things."
Ansel Adams

NBCC Exhibit “24 Exposures” at Community
Art Gallery at Holy Cross Hospital

Focus on NBCC Members

On December 1, 2009, “24 Exposures,” a photography exhibit by the North Bethesda Camera Club,
opens at the Community Art Gallery at Holy Cross
Hospital in Silver Spring, MD. The exhibit will run
through the end of January 2010. An Artists’
Reception is scheduled for Saturday, December 5,
from 12:00 noon to 2:00 pm. All members are invited
to attend and extend the invitation to family and
friends. Light refreshments will be provided.

Nikhil Bahl's photograph "Frosty Fall" was a finalist in
this 2009 Nature's Best Windland Smith Rice International Awards. Congratulations Nikhil!

Nature's Best Finalist

The Community Art Gallery is located in the
Professional and Community Education Center at
Holy Cross Hospital at 1500 Forest Glen Road, Silver
Spring, MD. Enter through the main entrance of the
building and turn right to enter the Art Gallery wing.
Garage parking is free for the first hour. We look
forward to seeing you at the opening reception.
Angelique Raptakis
Exhibits Chair
December, 2009
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2009 – 2010 NBCC Board of Directors, Standing, and Special Committees
President
Tom Sullivan

Vice President
Bob Dargel

Treasurer
Don Martell

Secretary
Jo Levine

Directors
Gordie Corbin
Bob Peavy

Voting Members in Bold

Programs/Workshops
Stu Mathison
Ira Adler
Nikhil Bahl
John Burgess
Jim Hawkins
Caroline Helou Don Martell
Kent Mason
Carl Root
Gerry Weiss

Competition
Judy Switt
Prints
David Davidson
Bill Ho
Bill Richards

Church Liaison
Chris Hanessian

Membership
Chuck Lee

Webmaster
Tom Field
Tom Sullivan

Exhibits
Angelique Raptakis
Dawn Sikkema
John Villforth

Awards Event Coordinator
John Villforth
Historian
Jean Hanson
Librarian
Chris Hanessian (temporary)

Judges
Marvin Sirkis
Roy Sewall
Paul Taylor

Hospitality
Carol Lee
Jim Render
Virginia Render
Terry van Houten

Electronic
Willem Bier
Tom Field
Alan Sislen

Community Outreach
Joel Hoffman
PSA Representative
Judy Burr

Bulletin Editor
José Cartas

Photo Essay
Stu Mathison
Bob Dargel
Tom Field

Field Trips
Frank Herzog
John Barnes
Deeva Garel
Alex Karlin
Cynthia Keith
Cheryl Naulty
Bill Olson

Education & Training
Kent Mason

Competition Image Review
Gordie Corbin
Tom Field
Carol Lee
Bob Peavy
Alan Sislen
Judy Switt
Anita van Rooy

